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SYLLABUS

Government of India, Ministry of Railways,

Railway Recruitment Boards
Recruitment of Junior Engineer (JE), Junior Engineer (Information Technology) [JE(IT)],
Depot Material Superintendent (DMS)

2" Stage CBT : Short listing of Candidates for the 2™ Stage CBT exam shall be based on the normalized marks obtained by

them in the 1*' Stage CBT Exam. Total number of candidates to be shortlisted for 2™ Stage shall be 15 times the community wise

total vacancy of Posts notified against the RRB as per their merit in 1% Stage CBT. However, Railways reserve the right to
increase/decrease this limit in total or for any specific category(s) as required to ensure availability of adequate candidates for all
the notified posts.

Duration : 120 minutes (160 Minutes for eligible PwBD candidates accompanied with Scribe)

No of Questions : 150

Syllabus : The Questions will be of objective type with multiple choices and are likely to include questions pertaining to General

Awareness, Physics and Chemistry, Basics of Computers and Applications, Basics of Environment and Pollution Control and

Technical abilities for the post. The syllabus for General Awareness, Physics and Chemistry, Basics of Computers and

Applications, Basics of Environment and Pollution Control is common for all notified posts under this CEN as detailed below:-

a) General Awareness : Knowledge of Current affairs, Indian geography, culture and history of India including freedom
struggle, Indian Polity and constitution, Indian Economy, Environmental issues concerning India and the World, Sports,
General scientific and technological developments etc.

b) Physics and Chemistry: Up to 10" standard CBSE syllabus.

c) Basics of Computers and Applications: Architecture of Computers; input and Output devices; Storage devices,
Networking, Operating System like Windows, Unix, Linux; MS Office; Various data representation; Internet and Email;
Websites & Web Browsers; Computer Virus.

d) Basics of Environment and Pollution Control: Basics of Environment; Adverse effect of environmental pollution and
control strategies; Air, water and Noise pollution, their effect and control; Waste Management, Global warming; Acid rain;
Ozone depletion.

e) Technical Abilities: The educational qualifications mentioned against each post shown in Annexure-A, have been grouped
into different exam groups as below. Questions on the Technical abilities will be framed in the syllabus defined for various
Exam Groups given at Annexure-VII-A, B, C, D, E, F & G.

The section wise Number of questions and marks are as below :

Subjects No. of Questions Marks for each Section
Stage-II Stage-11
General Awareness 15 15
Physics & Chemistry 15 15
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Basics of Computers and Applications 10 10
Basics of Environment and Pollution 10 10
Control

Technical Abilities 100 100
Total 150 150
Time in Minutes 120

The section wise distribution given in the above table is only indicative and there may be some variations in the
actual question papers.

Minimum percentage of marks for eligibility in various categories: UR -40%, OBC-30%, SC-30%, ST -25%. This
percentage of marks for eligibility may be relaxed by 2% for PwBD candidates, in case of shortage of PwBD
candidates against vacancies reserved for them.

Virtual calculator will be made available on the Computer Monitor during 2n Stage CBT.

2" Stage Syllabus for Electronics & Allied Engineering Exam Group — JE

1. Electronic Components & Materials :

Conductors, Semi conductor& Insulators; Magnetic materials; Jointing & Cleaning materials for U/G
copper cable & OFC; Cells and Batteries (chargeable and non chargeable); Relays, Switches, MCB &
Connectors.

2. Electronic Devices and circuits :

PN Junction diodes, thyristor; Diode and triode circuits; Junction Transistors; Amplifiers; Oscillator;
Multivibrator , counters; Rectifiers; Inverter and UPS.

3. Digital Electronics :

Number System & Binary codes; Boolean Algebra & Logic gates; Combinational & Sequential logic
circuits; A/D & D/A converter, counters; Memories

4. Linear Integrated Circuit :

Introduction to operational Amplifier; Linear applications; Non Linear applications; Voltage
regulators; Timers; Phase lock loop.

5. Microprocessor and Microcontroller :

Introduction to microprocessor, 8085 microprocessor working; Assembly Language programming;
Peripherals & other microprocessors; Microcontrollers

6. Electronic Measurements :

Measuring systems; Basic principles of measurement; Range Extension methods; Cathode ray
oscilloscope, LCD, LED panel; Transducers

7. Communication Engineering :

Introduction to communication; Modulation techniques; Multiplexing Techniques; Wave
Propagation, Transmission line characteristics, OFC; Fundamentals of Public Address systems,
Electronic exchange, Radar, Cellular and Satellite Communication.

8. Data communication and Network :

Introduction to data communication; Hardware and interface; Introduction to Networks and
Networking devices; Local Area Network and Wide area network; Internet working.

9. Computer Programming :

Programming concepts; Fundamentals of ‘C’ and C"~ Operators in ‘C’ and C" Control Statements;
Functions, Array String & Pointers, File Structure; Data Structure and DBMS

10. Basic Electrical Engg :

DC Circuits; AC fundamentals; Magnetic, Thermal and Chemical effects of Electric current; Earthing
- Installation, Maintenance, Testing
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RRB JE CBT-2

[ Electronics )

@xam Date: 22.04.2025

| Exam Time: 09:00 AM -11:00 AI\U

Section : General Abilities

1. What is the net force acting on an object if

balanced forces are applied?

(a) Equal to acceleration

(b) Zero

(c) Infinite

(d) Equal to the mass of the object
Ans. (b) : When balanced forces are applied the net
force acting on an object is zero. According to Newton's
first law of motion any object will be at rest position or
in motion until the unbalance force is applied. So when
balance force is applied, the net force is zero.

2. What is the purpose of the Collation option in
the Print settings?
(a) To change the printer selection
(b) To adjust the page orientation
(c) To select a custom print range
(d) To print all the pages of a document as a set
Ans. (d) : The purpose of the collation option in the
print settings is to print all the pages of a document as a
set.
When collation is applied in print settings, it prints
multiple copies of a multi page document.
For example if there is 4 page document and 3 collate is
enabled, it will print 1-2-3-4, 1-2-3-4, 1-2-3-4.
3. In an electric circuit, what is the correct way to
connect an ammeter?
(a) In series with the component
(b) In parallel with the component
(c) In either series or parallel
(d) In parallel with the source

Ans. (a) : In an electric circuit, the correct way to
connect an ammeter is in series with component.
Ammeter is a device used to measure current of a
circuit, it itself has low resistance, that's why it is
connected in series to measure current.

4. The fine powder that is obtained from the
modified and recycled form of plastic is called

(a) polyethylene (b) polystyrene

(c) polythene (d) polyblend
Ans. (d) : The fine powder that is obtained from the
modified and recycled form of plastic is called
polyblend. Polyblend is a type of plastic which is used
in many applications like in road constructions where it
is mixed with bitumen to increase the life span of roads.
It also makes roads less prone to moisture.

5. Who among the following inaugurated the 38"
National Games held in Dehradun in January
2025?

(a) Pushkar Singh Dhami
(b) Anurag Thakur

(c) Narendra Modi

(d) Droupadi Murmu

Ans. (¢) : Prime minister of India Mr. Narendra Modi
inaugurated the 38™ national games held in Dehradun in
January 2025. Narendra Modi is one of the prime
ministers who has been actively promoted sports and
physical fitness in the country through various
programmes like Khelo India program, National games
etc.
6. Which of the following states is NOT covered

under the Atal Bhujal Yojana?

(a) Maharashtra (b) Jharkhand

(c) Uttar Pradesh (d) Rajasthan
Ans. (b) The Atal Bhujal Yojana (ATALJAL)
includes the states of Gujarat, Haryana, Karnataka,
Madhya Pradesh, Maharashtra, Rajasthan and Uttar
Pradesh. Jharkhand is not covered under the Atal Bhujal
Yojana.

7. Identify the correct formula for the compound
formed between Mg®" and PO, ions.
(a) Mgy (POy)s (b) Mg(PO4)s
(c) MgPO, (d) Mgs(POq),
Ans. (d) : The correct formula for the compound
formed between Mg2+ and PO?{ ions is Mg;(POy),.
This chemical reaction is criss-cross method to build the
chemical formula of ionic bonds.

8. The Industrial Policy Resolution of 1956
categorised industries into how many groups ?
(a) Nine (b) Five
(c) Seven (d) Three

Ans. (d) : The industrial policy resolution of 1956

categorized industries into three groups.

Three groups-

1. Schedule A — Comprises of industries exclusively
owned by state.

2. Schedule B—~ Comprises of 12 industries which
would be progressively state- owned.

3. Schedule- C — Comprises of remaining industries

which were to be in the private sector.
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9. What is the primary purpose of using a firewall

on a Personal Computer?

(a) To clean up temporary files

(b) To speed up internet connectivity

(c) To block unauthorised access and protect the

computer

(d) To increase storage space
Ans. (c) : The primary purpose of using a firewall on a
personal computer is to block unauthorized access and
protect the computer. A firewall acts as a security
barrier between your computer's network and untrusted
networks like the internet, monitoring and controlling
incoming and outgoing traffic to prevent unauthorized
access.

10.

What is the approximate pH of a neutral salt

solution?

(a) More than 7

(c) Equalto 7
temperature

(b) Less than 7

(d) Depends on the

Ans. (c) : The approximate pH of a neutral salt solution
is equal to 7. pH is the scale used to measure the acid,
base categories of an aqueous solution.

pH=7 (Neutral solution)

pH <7 (Acidic solution)

pH >7 (Basic (Alkaline) solution)

11. 'What was the main objective of the Extremists
during the Indian National Movement?

(a) To attain complete independence (Swaraj)

(b) To promote British goods in India

(¢) To bring social reforms

(d) To expand the legislative councils

Ans. (a) : The main objective of the extremists during
the Indian National Movement was to attain complete
independence (Swaraj) Extremists wanted Swaraj that
means complete independence from the British rule.
Famous extremists leaders were Bal Gangadhar Tilak,
Bipin chandra pal and Lala Lajpat Rai, collectively
knowns the Lal- Bal - Pal.

12. In which of the following
Himalayas has the greatest width?
(a) Arunachal Pradesh (b) Sikkim
(c) Himachal Pradesh  (d) Kashmir

Ans. (d) : The Himalayas have their greatest width in
the Kashmir region. Himalayas are widest in Kashmir
due to the presence of multiple ranges as like Pir Panjal,
Zanskar and great Himalayan ranges.
13.  Which state of matter shows the highest
expansion when temperature is increased?
(a) Plasma (b) Solids
(c) Liquids (d) Gases
Ans. (d) : Gases state of matter shows the highest
expansion when temperature is increased.
Gases expand the most when heated because their
molecules are far distance away and have weak
intermolecular forces. That's why they move freely and
spread out significantly while temperature increases.

regions the

14. What is the maximum number of Ministers
allowed in the Council of Ministers, including
the Prime Minister, as per the 91° Amendment
Act ?

(a) 10% of Lok Sabha strength

(b) 20% of Lok Sabha strength

(c) 15% of Lok Sabha strength

(d) 12% of Lok Sabha strength

Ans. (c¢) : The maximum number of ministers allowed
in the council of ministers including the prime minister,
as per the 91% amendment act is 15% of the Lok Sabha
strength.

15.

What is the primary function of the F4 key in

MS Excel when editing a cell reference in a

formula?

(a) Opens the Find and Replace dialog

(b) Toggles between absolute and
references

(c) Repeats the last action

(d) Refreshes the worksheet

Ans. (b) : The primary function of the F4 key in, MS

Excel when editing a cell reference in a formula toggles

between absolute and relative references.

The function of F4 key is also useful to ensure that cell

reference behave as intended when formulae are copied

to different locations in the worksheet.

16.

relative

The main use of chlorofluorocarbons is in

(a) vehicles (b) smog

(c) chimneys (d) refrigerants
Ans. (d) : The main use of chlorofluorocarbons is in
refrigerants. Chlorofluorocarbons are acronymed as
(CFCs) are mainly used as refrigerants in AC systems,
refrigerators and freezers. CFCs are very useful to
efficiently transfer heat, making them ideal for cooling
applications.

17.

The phenomenon of multiple echoes due to
repeated reflections is called

(a) diffraction (b) reverberation

(c) resonance (d) refraction

Ans. (b) : The phenomenon of multiple echoes due to
repeated reflections is called reverberation. It is the
quality of sound persistence in the space due to multiple
reflections from surfaces like walls, ceilings or floors.
Reverberation is different from echo as it consists of
overlapping reflections than a clear repetition.

18.

Inertia depends on which property of an
object?

(a) Acceleration (b) Mass

(c) Velocity (d) Shape

Ans. (b) : Inertia is such a property of an object which
depends directly on mass. It resists in its state of]
motion. It is the descriptive principle of Newton's first
law of motion. Which describes that an object will
remain at rest or in motion unless acted by an external
force.
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19. Dr. BR Ambedkar described which part of the
Indian Constitution as its 'novel features',
while Granville Austin referred to it as the
'Conscience of the Constitution'?

(a) Directive Principles of State Policy

(b) Preamble

(c) Fundamental Rights

(d) Fundamental Duties

Ans. (a) Dr. Br Ambedkar described directive
principles of state policy of Indian constitution as its
‘novel features’ while Granville Austin referred to it as
the 'Conscience of the constitution'. The directive
principles of state policy is included in part- IV of the
Indian constitution. This part makes social and
economic welfare of the Indian citizen.

20.

Which of the following is the correct way to
insert a new column in a spreadsheet?

(a) Go to Home > Insert > Insert Sheet Columns.
(b) Go to File > New > Column.

(c) Press Ctrl + X and then Insert.

Ans. (b) : In most presentation software, including
Microsoft power point, the shortcut key to start a
slideshow from the beginning is F5.

Ctrl + P — Used to open the print dialog box.

Alt + Tab — Used to switch between open applications.
Shift + F5 — Used to start the slideshow from the
current slide, not the beginning.

24,

Which of the following is a characteristic

difference between colloids and true solutions?

(a) True solutions exhibit Brownian motion, but
colloids do not.

(b) True solutions show the Tyndall effect, but
colloids do not.

(c) True solutions have visible solute particles,
whereas colloids have invisible dispersed
particles.

(d) True solutions have a single-phase system,
whereas colloids have a two-phase system.

Ans. (d) Characteristic difference between
colloids and true solutions.

(d) Use Ctrl + Z to insert a column. True solution Colloid
Ans. (a) : Go to Home> Insert> Insert sheet columns. It have a single - phase | It have a two- phase
The above given sequence is the correct way to insert a| || system. system.
new column in the spreadsheet for inserting a new||| It is a homogeneous | It is a heterogeneous
column in applications like Microsoft Excel, go to home| || mixture of two or more | mixture of two
tab, click on insert and then choose insert sheet||| substances. substances.

columns.
21.

If you want the primary recipient to see that
others have received a copy of an email, you
should enter their email addresses in the

field.
(a) Subject (b) To
(c) Ce (d) Bee

Ans. (c) : If you want the primary recipient to see that
others have received a copy of an email, you should
enter their email addresses in the cc field.

Cc- Cc means Carbon Copy when recipients are added
in this field, all the people of Cc will get a copy of the
email. It will be visible to all other recipients also.

Bcc- Blind Carbon Copy (Bcec) is used when we don't
want to reveal other recipients could see the e-mail.

22.  What does PCB stand for?

(a) Primary Control Board

(b) Printed Circuit Board

(c) Peripheral Connection Bus

(d) Processing Circuit Board

Ans. (b) : PCB stands for Printed Circuit Board. It is a
non- conductive board with conductive pathways,
typically copper, etched or printed onto its surface,
which  mechanically supported and electrically
connected electronic components to form a functional.

23.

What is the shortcut key to start a slideshow
from the beginning?
(a) Ctrl+P

(c) Alt+ Tab

(b) F5
(d) Shift+F5

The size of particles is
less than one nanometer.

The range of particle size
between one nanometer to
1000 nanometer.

It is translucent.
The

It is always transparent.

The particles cannot be particles of a

seen even with | colloidal solution can be
microscope. seen with microscope.
It does not show tyndall | It show tyndall effect.
effect.

25.  Which of the following is NOT a component of

a CPU?

(a) Hard Disk

(b) Arithmetic Logic Unit (ALU)

(c) Cache Memory

(d) Control Unit (CU)
Ans. (a) : Hard Disk is not a component of a CPU.
A CPU has three main components-
The Arithmetic logic unit (ALU), which performs
calculation; the control unit (CU), which manages and
coordinates the operations of the entire CPU by issuing
control signals; and the cache memory and resistors,
which provide fast, temporary storage for data and
nstructions.

26.

Which of the following correctly explains why

clothes dry faster on a windy day?

(a) Wind removes the water vapour from the
clothes surroundings.

(b) Wind decreases the temperature of the water
molecules.
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(c) Wind reduces the surface area of the clothes.
(d) Wind increases the humidity around the
clothes.

Ans. (a) : Wind speeds up the drying process by
constantly removing the moist air around wet clothes,
allowing fresh, drier air to take its place. This
continuous removal of water vapor promotes
evaporation, which is why clothes dry faster on windy
days.
27.

What is the first step to securing ones
smartphone or tablet?

(a) Setting a password/PIN-protected lock screen
(b) Using only free Wi-Fi networks

(c) Installing more apps

(d) Turning off mobile data

Ans. (a) : Setting a password/ PIN protected screen is
the fundamental first step to securing your smartphone
or tablet. This basic security measure prevents
unauthorized access if your device is lost or stolen and
protects your personal information from being accessed
by others.

28.

The practice of Jhum cultivation is prevalent in
the .

(a) South east (b) North east

(c) South west (d) North west

Ans. (b) : The practice of Jhum cultivation is prevalent
in the 'North east. It is also known as shifting
cultivation. Northeastern states include Assam,
Meghalaya Mizoram, Nagaland, Arunachal Pradesh,
Manipur and Tripura. The hilly terrain and dense forests
of this region make it suitable for this method of]
agriculture.

29.

Which of the following companies announced
plans in February 2025 to construct the world's
longest undersea cable, aiming to enhance
internet connectivity across five continents,
with landing points in India?

(a) Amazon (b) Meta

(c) Google (d) Microsoft

Ans. (b) : In February 2025, meta announced project
waterworth, an initiative to construct the world's longest
undersea cable.

® Meta is a parent company of facebook, Instagram, and
whatsapp.

® The cable will span over 50000 km, connecting five
continents, including the United States, Brazil, India
and South Africa.

® The aims of this project to enhance global internet
connectivity and support infrastructure.

30.

What happens when an acid reacts with a
metal oxide?

(a) A salt and water are formed.

(b) Only salt is formed.

(c) A salt and hydrogen gas are formed.

(d) Only water is formed.

Ans. (a) : A salt and water are formed when an acid
reacts with a metal oxide.
Example:-  Cy0 + 2HCI—> (‘jlc’l_. +H,0
(Metal)  (Acid) (Salt) (\T\el’l;ter)
Oxide

31. The glass panel used in greenhouses is known

toretain __

(a) heat (b) pH

(c) humidity (d) rainfall
Ans. (a) : The glass panel used in greenhouses is
known to retain heat from the sun, creating a warm,
controlled environment inside for plant growth
through the greenhouse effect.
Difference between horticultural
toughened safety glass -

glass and

Horticultural glass

It is the traditional
standard glass used in

Toughened safety glass

It is also known as tempered
glass, it is standard glass

greenhouses. It's | that has undergone a heating
untreated and | and rapid cooling process.
relatively fragile

making it prone to

breakage from impacts

like footballs.

It is fragile and breaks | It is up to four times
into large, sharp | stronger than standard glass

pieces, which can be | and, when it breaks, it
dangerous to people | shatters into thousands of
and plants. tiny  blunt fragments,
drastically reducing the risk

of injury.
32. Why does a bee sting cause pain and irritation?

(a) The string releases carbon dioxide gas.
(b) The sting contains a strong base.
(c) The sting injects a mild sugar solution.
(d) The sting injects methanoic acid.

Ans. (d) : A bee sting causes pain and irritation because
it injects venom containing compounds like methanoic
acid.
These chemicals trigger a localized inflammatory
response in the skin, leading to symptoms such as
redness, swelling, and burning sensation, which signals
the immune system to remove the foreign substance.
33.  Which of the following is NOT toxic to non-

target organisms in the soil?

(a) Organic fertilisers  (b) Pesticides

(c) Fungicides (d) Herbicides
Ans. (a) : Organic fertilisers is not toxic to non- target
organisms in the soil.
These are derived from natural sources like compost,
manure and plant residues. They improve soil fertility
and structure by promoting beneficial microbial activity
and providing nutrients.
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34.  Which of the following correctly represents the
chemical formula of a compound formed by

aluminium and sulphate ions?

(a) ALSO,4 (b) AL(SOq4)s
(c) Al(SO4); (d) AL(SO4),
Ans. (b) The correct chemical formula for a

compound formed by aluminium and sulphate ions is
Aly(SOy)s. This compound is commonly known as
aluminium sulphate, which is wused in paper
manufacturing, water purification and as a mordant in
dyeing and printing textiles.

35. The primary agent that helps in the
decomposition of biodegradable matter in
domestic sewage is

(a) phosphate (b) nitrate

(c) bacterium (d) chloride

Ans. (¢) : Bacterium is a primary agent that helps in the

decomposition of biodegradable matter in domestic

sewage.

® Bacteria and other microorganisms, like fungi and
protozoa, are the central agents in wastewater
treatment.

® Decomposition by bacteria occurs under both

aerobic and anaerobic conditions in sewage
treatment plants.
® Bacteria play a crucial role in maintaining

environmental balance by recycling nutrients and
reducing organic pollution in wastewater.
The energy that is derived from the use of
radioactive isotopes is termed as
(a) nuclear energy (b) geothermal energy
(c) thermal energy (d) solar energy

36.

Ans. (a) : Nuclear energy is a energy that is derived
from the use of radioactive isotopes.

Energy derived from radioactive isotopes is a process
where the nucleus of an atom is fission or fusion,
releasing a large amount of energy and is classified as
nuclear energy.

37. The Rudra Veena is predominantly associated
with which genre of Hindustani music ?
(a) Thumri (b) Dhrupad
(c) Khayal (d) Ghazal

Ans. (b) The Rudra Veena is predominantly

associated with the Dhrupad genre of Hindustani

classical music.

® This ancient string instrument, known for its deep
and rich sound, is used to create the spiritual and
meditative atmosphere that is central to the Dhrupad
style, which is one of the oldest forms of Indian
classical music.

38. What happens when a computer is put into

Sleep mode?

(a) Tt keeps the session active in RAM while
using using minimal power.

(b) It shuts down completely.

(c) It restarts automatically after a few minutes.
(d) It shores data on the hard drive and powers
off.
Ans. (a) : When a computer is put into sleep mode then
it keeps the session active in RAM while using minimal
power.
Advantages of putting a computer into sleep mode:-
e The computer uses very little electricity (Only
enough to keep data in RAM).
® It helps in reducing power consumption, especially
for laptops.
e Useful when you take short breaks.
All open files and programs remain stored in RAM,
so your work is ready as it was when you left.
® |t reduces hardware wear and extends system life.

39.

If an object is dropped from rest, what will be
its velocity after 15 seconds? (g = 9.8 m/s?)
(a) 149 m/s (b) 143 mv/s

(c) 145 m/s (d) 147 m/s

Ans. (d) : Given that,

The object is dropped from rest so, initial velocity (u) =
0

Time (t) = 15s

Gravity (g) = 9.8 m/s”
Final velocity (v) = ?
from kinematic equation

v =utgt

v=0+98x15

v =147 m/s

40. Which official in the Gupta administration was

responsible for peace and war matters?
(a) Sandhi-Vigrahika  (b) Vishayapati
(c) Mahapratihara (d) Mahadandanayaka
Ans. (a) : In the Gupta administration, Sandhi -
Vigrahika was responsible for matters of peace and war.
This officer assisted the king in negotiating treaties,
handling military conflicts, and making important
decisions regarding foreign policy.
® The minister of war and peace was known as Sandhi-
Vigrahika.
® [t was the most important rank in the councils of
minister under the Gupta administration.

41. If the absolute refractive index of a medium is

less than 1, it means

(a) light travels faster in that medium than in
vacuum

(b) the medium absorbs all light

(c) light travels slower in that medium than in
vacuum

(d) the medium is a perfect reflector

Ans. (a) : If the absolute refractive index of a medium
is less than 1, it means light travels faster in that
medium than in vaccum.
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® Refractive index is a dimensionless number that
describes how light propagates through a medium.
e Refractive index is also equal to the velocity of light
‘¢’ of a given wavelength in empty space divided by
its velocity ‘v’ in a substance or.

c
n=—-
v

Where,
1 — Refractive index
¢ — Speed of light
v — Phase velocity of light

42. The Millennium Development Goals (MDGs)
aimed to reduce extreme poverty by which year

?
(a) 2015 (b) 2014
(c) 2008 (d) 2005

Ans. (a) : The millennium Development Goals (MDGs)

aimed to reduce extreme poverty by 2015.

® This was one of the eight international development
goals that were established at the UN millennium
summit in 2000.

® These goals were adopted by 189 united nations
member states during the millennium summit held in
September 2000.

43. Which of the following CANNOT be
considered as a measure to control global
warming?

(a) Efficiently using energy

(b) Cutting down use of fossil fuel

(¢) Reduction in emission of greenhouse gases
(d) Causing deforestation

Ans. (d) : Deforestation increases CO, level as trees

absorb carbon dioxide.

Hence, causing deforestation worsens global warming.

It cannot be considered a control measure.

44. Which of the following cities hosted the
inaugural Kho Kho World Cup in January

2025?
(a) Mumbai (b) Chennai
(c) New Delhi (d) Kolkata

Ans. (¢) : The inaugural Kho-Kho world cup-2025 was

hosted in New Delhi, India.

® The event marked the first- ever global tournament
for the traditional Indian  sport, organized to
promote Kho-Kho internationally.

® ndia defeated Nepal in both the men's and women's
competition to be crowned champions.

45. Which of the following is NOT a source of

release of smokestacks?

(a) Rivers

(b) Smelters

(¢) Industries

(d) Thermal power plants

Ans. (a): Smokestacks release gases and pollutants
from industries, smelters, and thermal power plants.
Rivers do not emit smoke or gases. Hence, they are not
a source of smokestacks release.

46. Which Article provides Ministers the right to
participate in parliamentary proceedings but
without voting rights?

(a) Article 53 (b) Article 88
(c) Article 77 (d) Article 78

Ans. (b) : Article 88, provides ministers the right to

participate in parliamentary proceeding but without

voting rights.

e This article states that every Minister and the
Attorney- General of India has the right to speak in
and take part in the proceedings of either house of
parliament, any joint sitting, or any committee, but
is not entitled vote by virtues of this article.

47. The maximum sound is generated

(a) from industrial smoke

(b) by the take off of a jet plane
(¢) from house chimneys

(d) from vehicular emissions

Ans. (b) : The maximum sound is generated by the take

off of a jet plane.

® Jet planes during take - off produce an extremely
high level of noise due to their powerful engines and
high speeds, often exceeding 140 dB.

® This intense noise can cause immediate hearing
damage if exposed closely.

48. According to the Tendulkar methodology, what

was the estimated percentage of people below
the poverty line in rural areas in 2011-12?

(a) 27.5% (b) 25.7%

(c) 20% (d) 15.5%

Ans. (b) : According to the Tendulkar methodology, by

estimated percentage of people below the poverty line

in rural areas in 2011-12 was 25.7%.

49. Which defect of vision occurs due to the

weakening of ciliary muscles with age?

(a) Hypermetropia (b) Myopia

(c) Astigmatism (d) Presbyopia

Ans. (d) : The defect of vision that occurs due to the

weakening of ciliary muscles with age is Presbyopia.

® Presbyopia is an age - related condition where the

lense becomes less flexible, making it difficult to

focus on near objects due to the weakening of the
ciliary muscles.

50. What is India's global military ranking in the

2025 Global Firepower (GFP) index?

(2) 5" (b) 4%

(C) 2nd (d) 3rd

Ans. (b) : India has secured the 4™ position globally in
the global firepower index 2025, solidifying its states as
one of the world's most powerful militaries after the
united states, Russia, and china.
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Section: Technical Abilities
1. The magnetic field inside a solenoid is:
(a) circular and varying with distance
(b) zero
(c) uniform and parallel
(d) non-uniform and divergent

Ans. (¢) : The magnetic field inside a solenoid is

uniform and parallel to the axis of the solenoid.

e When an electric current flows through the coils of
solenoid it creates a magnetic field that is strong and
almost constant inside the solenoid.

e This magnetic field lines run parallel to each other
along the length of the solenoid indicating that the

field is uniform.

2. Co-axial cables are most commonly used in
which of the following applications?
(a) Underwater communication
(b) Satellite communication
(c) Cable television (CATV) systems
(d) Wireless communication networks

Ans. (¢) : Co-axial cables are most commonly used in

cable television (CATV) systems.

e Coaxial cables are designed to transmit high-quality
signals with minimal interference.

e Co-axial cable are used in such applications as
telephone trunk lines, broadband internet networking
cables, cable television signals etc.

e It is used as a transmission line for radio frequency
signals.

3. For an RC phase shift oscillator, which of the

following statements is INCORRECT?

(a) The total phase shift of the RC network is

180°

(b) The magnitude of the gain of the RC network

is>1/29

(c) The magnitude of gain of the amplifier must

be =29

(d) The oscillation frequency of the oscillator is

1

2nRC\/g

RC Phase Shift Oscillator
e The magnitude of the gain of the RC network is less
than 1.
e The magnitude of gain of the amplifier must be > 29.
e The oscillation frequency of the oscillator is
1

2nRCV6
Hence, option (b) is incorrect.
4. What is the primary goal of simplifying a
Boolean expression before implementing it with
gates?
(a) To make the circuit slower
(b) To increase the number of gates

(c) To reduce the number of gates
interconnections

(d) To increase power consumption
Ans. (¢) : The primary goal of simplifying a Boolean
expression before implementing it with logic gates is to
reduce the number of gates and interconnections.
The simplification of a Boolean expression helps-
e Reducing the number of logic gates required to
implement the circuit.
e Minimizing interconnections between gates, which
makes the circuit less complex.
¢ Improving circuit speed since fewer gates and shorter
paths reduce delay.
e Low power consumption and cost which are important
in real-world applications.
5. What material is primarily used as the core in
fiber optic cables?
(a) Copper (b) Plastic
(c) Aluminium (d) Glass
Ans. (d) : Glass is primarily used as the core in fiber
optic cables.
e The core of a fiber optic cable is the central part
through which light signals are transmitted.
e The material used for the core must have the ability to
carry light efficiently with minimal loss.

and

® High purity silica glass is primary material used
because it allows light to travel long distances with
very low loss.

Ans. (b) : In an RC phase shift oscillator, we typically
use three RC stages in series to provide a total phase
shift of 180°.

™

A
Vi

6. The magnetic field outside a toroidal coil:
(a) is zero

(b) is in a circular pattern around the toroid
(c) is uniform and points radially outward
(d) is uniform and points radially inward

Ans. (a) : The magnetic field outside a toroidal coil is

Zero.

e A toroidal coil is a coil wound into a circular ring
shape like a doughnut.

e It is commonly used in inductors and transformers
because of its excellent magnetic properties.

e The net enclosed current outside the toroid is zero,
that's why the magnetic field outside a toroidal coil is

Z€ro.
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7. What type of error occurs due to unpredictable
variations in measurement conditions?
(a) Gross error (b) Random error
(c) Calibration error (d) Systematic error

Ans. (b) : Random error occurs due to unpredictable

variations in measurement conditions.

e The Random errors can arise from; sudden changes in
environmental conditions (like temperature, humidity
or vibrations) and slight fluctuations in instrument
performance.

8. Which of the following statements w.r.t. FSK

demodulation using PLL circuit is/are correct?
S1: If the input signal frequency changes, the
PLL adjusts its frequency output to match the
input frequency.

S2: The phase-locked loop is used to track the
changes in the frequency of the modulated
signal.

(a) Only S1 (b) Only S2

(c) Neither S1 nor S2  (d) Both S1 and S2

Ans. (d) : The basic working of a PLL used in FSK

demodulation-

® A PLL continuously compares the phase of the input
signal with the output of a voltage controlled
oscillator (VCO). If the input frequency changes the
PLL adjusts the VCO to match the new frequency
effectively locking onto.

e The phase-locked loop (PLL) tracks the shifts in
frequency, which correspond to the digital bits (one
frequency for '0' and another for 'l'). The PLL's
ability to follow these changes allows it to
demodulate the FSK signal effectively.

Therefore both statements S; and S, are correct.

9. Which of the following is NOT a type of loop in

C?

(a) do-while loop

(c) while loop

(b) for each loop

(d) for loop

Ans. (b) : In the C programming language loops are

used to execute a block of code repeatedly.

The following are valid types of loops in C-

1. For loop- Repeats a block of code a known number
of times.

2. While loop- Repeats a block as long as a condition is
true.

3. Do-while loop- Similar to while loop but guarantees
the block runs at least once.

e For each loop is not a valid loop in C. It is used in
other programming languages like C™" , PHP, and
python for iterating over collections or arrays in a
simplified manner.

10.  Which of the following is an example of a Wide
Area Network (WAN)?
(a) A home Wi-Fi network

(b) The internet

(c) A Bluetooth connection
(d) A local office network

Ans. (b) : The internet is an example of a Wide Area

Network (WAN).

e WAN spans a large geographical area and is used to
connect multiple smaller networks such as local area
Networks (LANS).

o It allows data communication over long distances,
such as between cities, countries or even continents.

o A home Wi-Fi network and a local office network are
the examples of LAN.

e A Bluetooth is an example of a Personal Area
Network (PAN).

What type of distortion occurs if a signal that
contains frequency components up to 15 kHz is
sampled using 20kHz?
(a) Quantization error
(c) Slope Overload (d) No distortion

Ans. (b) If a signal that contains frequency

components up to 15 kHz is sampled using 20 kHz,

aliasing type of distortion occurs.

e A signal must be sampled at a rate at least twice the
highest frequency present in the signal to avoid
aliasing.

e But, the signal is being sampled at only 20 kHz

which is less than the Nyquist rate, due to this reason

aliasing will occur.
The function of pin 18 and 19 (XTAL1 and
XTAL2) in 8051 Microcontroller is .
(a) to control external interrupt
(b) oscillator connection for clock generation
(c) address and data bus decoding
(d) serial data transmission

Ans. (b) : In the 8051 microcontroller, pins 18

(XTALI1) and 19 (XTAL2) are used to connect an

external crystal oscillator or resonator for clock

generation.

e These two pins are internally connected to a crystal

oscillator circuit within the microcontroller, which

helps to generate the clock signal required for the
operation of the 8051 microcontroller.

11.

(b) Aliasing

12.

13. The Multiplexed address and Data lines in the
8085 microprocessor are .
(a) AD7 - ADO (b) ADS- ADI

(c) AD8- ADI5 (d) AD9 - AD16

Ans. (a) : The multiplexed address and Data lines in the

8085 microprocessor are AD; —AD,.

e During the first part of a machine cycle, these lines

carry the lower 8 bits of the address (A to A5).

e In the next part of the cycle, the same lines are used to
carry 8-bit data (D, to D).

e This technique of multiplexing helps reduce the
number of physical pins needed on the

microprocessor chip.
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e To separate the address from the data an external latch
is used with the help of a control signal called ALE
(Address Latch Enable).
Which of the following is a key feature of a
microprocessor-based over current relay that
enhances its performance in fault detection?
(a) It uses analogue components to process
current signals.
(b) It only protects against short-circuit faults.
(c) It incorporates fault analysis algorithms to
identify fault types.
(d) It does not require a power supply for
operation.

14.

Ans. (¢) : A microprocessor - based over current relay
is an advanced protection device used in electrical
systems. One of its key features is the use of digital
signal processing and intelligent algorithms to enhance
fault detection and system protection.
e Microprocessor-based relays use software algorithms
to analyze fault conditions such as over current, short
circuit, ground faults etc.
What does 'PROM' stand for?
(a) Processing Read-Only Memory
(b) Peripheral Read-Only Memory
(c) Primary Read-only Memory
(d) Programmable Read-Only Memory
Ans. (d) : PROM stands for Programmable Read-Only
Memory.
¢ RAM - Random Access Memory
* ROM - Read Only Memory
e EPROM - FErasable Programmable Read Only
Memory.
e EEPROM - Electrically Erasable Programmable Read
Only Memory.
Which of the following statements are true
regarding the eye diagram in the
communication system?
(A) An eye diagram is used to investigate Inter
symbol interference.
(B) The width of the eye-opening indicates an
interval where the wave can be sampled
without ISI.
(C) Eye diagram is observed in Digital storage
oscilloscope.
(a) Only A and C (b) A,BandC
(c) Only A and B (d) Only B and C
Ans. (b) : An eye diagram is a powerful tool used in
digital communication systems to assess the quality of a
signal, especially in the presence of noise, jitter and
inter symbol interference (ISI).
e An eye diagram is used to investigate inter symbol
interference (ISI).
e The width of the eye-opening indicates an internal

15.

16.

where the wave can be sampled without ISI.
e Eye diagram is observed in digital storage
oscilloscope

17. The IO/M signal in the 8085 microprocessor

specifies

(a) Whether an interrupt has occurred

(b) Whether the data is valid

(c) Whether the operation is read or write

(d) Whether the operation is memory or I/O
related

Ans. (d) : The I0/M signal in the 8085 microprocessor
specifies whether the operation is memory or I/O
related.

e When I0/M = 0, it indicates that the microprocessor
is accessing memory.

e When IO/M = 1, it indicates the microprocessor is
accessing an input or output device.

e This signal works in combination with Read (RD)

and write (WI_{) appropriate control actions.

18. In the 8085 microprocessor, instruction

is used to identify pending interrupts.

(a) ANI (b) SIM

(¢) RIM (d) LXI

Ans. (¢) : The RIM (Read Interrupt Mask) instruction in

the 8085 microprocessor is used to identify pending

interrupts.

e RIM instruction is used to check the status of]
interrupts, including which interrupts are masked
(disabled) and which are pending.

e [t is used to read the serial Input Data line (SID).

e When the RIM instruction is executed, it loads the
accumulator with an 8-bit value.

19. How do you declare a pointer to an integer?
(a) int *ptr; (b) pointer int ptr;

(c) int ptr*; (d) int ptr;

Ans. (a) : To declare a pointer to an integer, we use the
syntax: int*ptr;.

e In C programming, a pointer is a variable that stores
the memory address of another variable.

20. The 8051 microcontroller has /0
pins.
(a) 24 (b) 40
(c) 26 (d) 32

Ans. (d) :

e It has contain total 40 pins DIP, 32 of those pins are
used as general-purpose Input/output (I/O) pins.

e These 32 Input pins are divided across 4 ports:
e Port 0 — 8 bits (pins 32 -39)

e Port 1 — 8§ bits (pins 1- 8)

e Port 2 — 8 bits (pins 21-28)

e Port 3 — 8 bits (pins 10-17)
The bandwidth of a raised cosine filter with

roll-off factor B (0 to 1) and symbol rate Rg is
given by

21.
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(@) BW=Rs2p+1)  (b) BW=Rs(p+1)

(c) BW = %(132+ D () BW- %(w 1)

Ans. (d) : The bandwidth of a raised cosine filter with
roll-off factor B (0 to 1) and symbol rate Rg is given by-

BW:%(BH)

e A raised cosine filter is a type of filter commonly used
in digital communication systems to shape the
transmitted signal and minimize intersymbol
interference (ISI).

o It is useful for pulse shaping in digital modulation
techniques.

22.  Which of the following statements best

describes the operation of a bridge rectifier?

(a) In a bridge rectifier, current flows through
two diodes during both positive and negative
half cycles, leading to very high-power loss.

(b) The peak inverse voltage (PIV) of diode in a
bridge rectifier is the same as in a center-
tapped rectifier.

(c) The output voltage of a bridge rectifier
consists of only DC components with no AC
ripples.

(d) The bridge rectifier is a full-wave rectifier

that does not require a center-tapped
transformer, improving transformer
efficiency.

Ans. (d) : The full wave bridge rectifier does not
require a center-tapped transformer.
e The bridge rectifier uses four diodes arranged in a
bridge configuration.
e [t converts both the positive and negative half-cycles
of the input AC signal into a unidirectional output
(like DC).
In which of the following electrical applications
is a glass insulating material commonly used?
(a) Power cables and conductors
(b) High-voltage switchgear and transformers
(c) Low-voltage electronic circuits
(d) Electrical wires for home appliances
Ans. (b) : The high voltage switchgear and transformers
electrical applications is a glass insulating material
commonly used due to its-

e High dielectric strength.
e Resistance to moisture and chemical corrosion.
e Thermal stability.

24,

23.

What happens to the carry-out bit when
subtracting two n-bit numbers using 2's
complement and the result is positive?

(a) The carry-out bit indicates an overflow

(b) The carry-out bit is added to the result

(c) The carry-out bit is inverted

(d) The carry-out bit is ignored

Ans. (d) : The carry-out bit is ignored when subtracting
two n-bit numbers using 2's complement and the result
is positive.

In 2's complement arithmetic, subtraction is

performed by adding the 2's complement of the

subtrahend to the minuend.

e The carry-out bit is a by product of this addition but it
does not indicate overflow in 2's complement.

e When the result of an n-bit 2's complement
subtraction is positive, a carry-out from the MSB
might occur.

e In 2's complement representation, the carry-out is
ignored or discarded.

25.  The output voltage of an IC 7905 is
(a) 15V (b) 5V
(c) -15V (d) -5

Ans. (d) : The output voltage of an IC 7905 is —5V.

e The IC 7905 is a part of the 79XX series of negative
voltage regulators.

¢ '79" indicates negative voltage regulation.
¢ '05" indicates the output voltage which is 5 volts.
e Since it's 79XX series, the output is —5 volts.

e IC 7905 provides a fixed output voltage of -5V,
which is typically used in circuits that require
negative supply voltage.

26. Which of the options is correct for a non-

inverting OP-AMP?

(a) Input is applied at the inverting terminal of
OP-AMP.

(b) Non-inverting terminal of OP-AMP is
grounded.

(c) For an negative input, output is positive
(d) Output is in phase with input

Ans. (d) : In a non-inverting operational amplifier, the
output signal is in phase with input signal.

e The input signal is applied to the non-inverting

terminal in a non-inverting Op-Amp.
R'.

AAYA

R

w [ v

: V:I\ +

¢ Voltage gain of a non-inverting Op-Amp is

:1+&
R

i

A

A%

e It has high input impedance and low output
impedance.

o Negative feedback is applied to the inverting input of]
a non-inverting op-amp.

27. A Zener diode has a breakdown voltage of
V., 7 V at 300 K, with a temperature

coefficient of 2.3 mV/°C. What is the new

breakdown voltage V, at 400 K?
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a7V
(c) 6.77V
Ans. (b) : Given,
Breakdown voltage V, =7V
Temperature coefficient = 2.3mV/C
Temperature, T; =300 k
T, =400 k
AT =400-300 = 100K
AT = Temperature coefficient XAT
= 2.3x107° x100 =0.23V

Now, Breakdown voltage at 400K = V; (300K) + AV

=7+0.23=7.23V

For a diode operating in forward bias, which of

the following statements is INCORRECT?

(a) The reduction in the width of the depletion
region is due to the recombination of charge
carriers and immobile ions near the junction.

(b) The reduction in the potential barrier occurs
due to the narrowing of the depletion region.

(c) The reduction in the depletion region allows a
majority carrier flow across the junction.

(d) The reduction in the depletion region causes a
heavy flow of minority carriers across the
junction.

Ans. (d) : For a forward biased diode-

o The recombination of carriers and the movement of in
mobile ions near the junction indeed leads to
reduction in the width of depletion region.

o As the depletion region narrows in forward bias, the
potential barrier reduces.

e The narrowing of the depletion region allows majority
carriers to cross the junction and create current.

e Heavy flow of minority carriers is characteristics of]
reverse bias, not forward bias.

Hence, option (d) is incorrect.

29.

(b) 723V
(d) 6.977V

28.

A bridge-rectifier is connected to a 24 sin(ot) V
supply. What is the peak inverse voltage (PIV)
across the diode?

(a) 48/mV (b) 24V
() 12V ) 24/nV

Ans. (b) : In a Bridge rectifier, the peak Inverse voltage
(PIV) across each diode = V,

Given, Vi, =24 sin (wt) Volt

Where,
V=24 Volt
So,
PIV =24 Volt
30. What is the primary function of the cathode

ray tube (CRT) in an oscilloscope?

(a) To display waveforms of the electrical signals
(b) To amplify the electrical signals

(c) To measure the frequency of the signals

(d) To convert the electrical signals into sound

Ans. (a) : The primary function of the Cathode Ray

Tube (CRT) in an oscilloscope is to display waveforms

of the electrical signals.

e The CRT converts electrical signals into visual
display by using an electron beam.

e Electron beam moves across the screen in response to
electrical input, creating a visible trace or waveform.

31. Which of the following statements is correct

regarding the ripple factor of different

rectifiers?

(a) A bridge rectifier has a better ripple factor
than a centre-tapped rectifier.

(b) A full-wave rectifier has a higher ripple factor
than a half-wave rectifier.

(c) A half-wave rectifier has more than twice the
ripple factor of a full-wave rectifier.

(d) A rectifier with a higher ripple factor is more
preferable for DC power supply than one with
a lower ripple factor.

Ans. (¢) : The ripple factor of half-wave rectifier is

more than twice the ripple factor of a full-wave rectifier.

We know that,

The ripple factor of half-wave rectifier rgwr) = 1.21

and the ripple factor of full-wave rectifier rewr) = 0.482

T,
oy _ 121 5

0.482

Note- The ripple factor indicates the amount of AC
contents present in the DC output of a rectifier.

32.

Now,

Lrwr)

What are the input and output impedances of a
voltage-series feedback amplifier?

Given:

Input impedance without feedback: R; = SkQ
Output  impedance  without feedback:
Ry =10kQ

Feedback factor: AR =19

(a) 0.25kQ,0.5kQ (b) 100kQ,200kQ

(c) 0.25kQ,200kQ  (d) 100kQ,0.5kQ
Ans. (d) : Given,

R;=35kQ, Ry=10kQ
Feedback factor Ap =19
We know that,

The input impedance of voltage-series feedback
amplifier,
Rir=R; (1+ AB)
=5x10°(1+19)
=100 kQ
The output impedance of voltage - series feedback
amplifier
= RO
(1+AB)
~10x10°

———=0.5kQ
(1+19)

Rt
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33. In common collector configuration of BJT,

which of the following options is correct?

(a) It has very high input impedance due to the
presence of emitter resistance.

(b) It has a lower input impedance than a
common-emitter amplifier.

(c) The input characteristics are a plot of input
current (Ig) vs. input voltage (Vgg) for a
constant Ig.

(d) If the emitter resistance is bypassed with a
capacitor, the input impedance increases.

Ans. (a) : Common collector configuration of BJT
(Emitter follower) has very high input impedance due to
the presence of emitter resistance.

34. In circuit switching, a dedicated
communication path is established between the
sender and the receiver. This technique is
primarily used in which of the following
networks?

(a) Cellular networks

(b) Internet

(c) Wireless Local Area Networks (WLANs)

(d) Public Switched Telephone Network (PSTN)

Ans. (d) In circuit switching, a dedicated
communication path is established between the sender
and the receiver for the duration of the call. This
technique is primarily used in Public Switched
Telephone Network (PSTN).

PSTN : (Public Switched Telephone Network)

e PSTN is the traditional telephone system that has

been in use for many decades.

e [t provides the infrastructure and services for publics
telecommunication.

35.  Which modulation technique is used to avoid
phase ambiguity in BPSK?

(a) QPSK (Quadrature Phase Shift Keying)

(b) ASK (Amplitude Shift Keying)

(c) FSK (Frequency Shift Keying)

(d) DPSK (Differential Phase Shift Keying)

Ans. (d) : Differential phase shift keying (DPSK)
modulation technique is used to avoid phase.

eDPSK is a modulation technique in digital
communication where data is encoded by changes in
phase rather than absolute phase values, relative to the
preceding bit.

Ans. (d) :
Ao oD
B e—l Full
Subtractor —eB_,
B,e—
Difference (D) = ABB,, + ABB,, +ABB, + ABB,
= A(BB, +BB, )+ A(BB, +BB,))
= A(B®B,)+A(B®B, )
=A®B®B,
Output Borrow (Bo) = AB+ AB, + BB,
Truth table
Inputs Outputs
A B Bi D B,
0 0 0 0 0
0 0 1 1 1
0 1 0 1 1
0 1 1 0 1
1 0 0 1 0
1 0 1 0 0
1 1 0 0 0
1 1 1 1 1
37. One of the main advantages of AAAC (All

Aluminium Alloy Conductor) over AAC (All

Aluminium Conductor) is:

(a) increased weight for
strength

(b) higher corrosion resistance

(¢) reduced cost of production

(d) lower conductivity

better mechanical

Ans. (¢) : The main advantages of All Aluminium Alloy
conductor (AAAC) over All Aluminium conductor
(AAC) are higher corrosion resistance and better
mechanical strength.

e AAAC is used in long-span transmission and
distribution lines and also coastal or industrial areas.

38.

In the case of a 360° phase shift between two
signals, the time delay will be equal to:

(a) half the period of the signal

(b) a quarter of the period of the signal

(c) twice the period of the signal

(d) one period of the signal

36. Which Boolean expression correctly represents
the Difference (D) output of a Full Subtractor?
(a) D=A®B

(b) D=AANDB

(c) D=A@ B ® Cou

(d D=A®B® B,

Ans. (d) : In the case of a 360° phase shift between two
signals, the time delay will be equal to one period of the
signal.

Given, ¢=360°
(I) x T
360°

Time delay (At) =
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Where,

¢ = phase shift

T = time period of the signal
_360°
©360°

At=1xT
Hence, A 360° phase shift will be equal to one period of]

At

xT

the signal.
39. Which of the following are Pulse Time

Modulation (PTM) techniques?

(a) PAM and PCM (b) PDM and PCM

(c) PPM and PAM (d) PWM and PPM
Ans. (d) : Pulse width modulation (PWM) and pulse
position modulation (PPM) are pulse time modulation
(PTM) techniques.
oPTM refers to modulation techniques where the
information is conveyed by changing the timing
characteristics of pulses in a signal ,rather their
amplitude.

40. Which of the following factors is directly
proportional to the eddy current loss in
magnetic materials?

(a) Magnetic field frequency

(b) Thickness of the material

(c) Temperature of the material

(d) Permeability of the material

Ans. (a, b) : The square of both magnetic field
frequency and thickness of the material are directly
proportional to the eddy current loss in magnetic
materials.

e Eddy current loss P, =k B.f’t’V
P ocf 2t?
where, k = Eddy current Coefficient
B, = Magnetic flux density
f= Magnetic field frequency
t = Thickness of the material
V = Volume of the magnetic material’s
Note: For this question, discrepancy is found in

question/answer. So, this question is ignored for all
candidates.
41. In a circuit, if the voltage across a resistor is

doubled and the resistance remains constant,
what happens to the current?

(a) The current remains the same

(b) The current is halved

(¢) The current doubles

(d) The current quadruples

Ans. (¢) : In a circuit if the voltage across a resistor is
doubled and the resistance remains constant, then the
current will be double.

e We know that,

I :% (by Ohm'slaw )

if V=2V and R remains constant the ' = —

['=2I

42.  Which of the following characteristics is ture

for ferromagnetic materieals?

(a) They retain their magnetisation even after the
external magnetic field is removed.

(b) They are weakly repelled by a magnetic field
and have negative magnetic susceptibility.

(c) They show no effect in a magnetic field and
are considered neutral.

(d) They are strongly attracted to a magnetic field
but do not exhibit hysteresis.

Ans. (a) : The true characteristics for ferromagnetic
materials like iron (Fe), cobalt (Co), nickel (Ni) is that
they retain their magnetisation even after the external
magnetic field is removed.
e This is due to the alignment of magnetic domains
inside the material.
e Diamagnetic materials like copper (Cu), bismuth (Bi)
are weakly repelled by a magnetic field and have
negative magnetic susceptibility.
43. What is the purpose of fscanf() in C?

(a) Writes formatted data to a file

(b) Reads formatted data from a file

(c) Closes a file

(d) Reads a single character from a file
Ans. (b) : Reads formatted data from a file is the
purpose of fscanf() in C language.
o fprint () is used to write formatted data to a file.
o Closes a file is done by fclose().
e Reads a single character from a file is done by fgetc().
44,

Which Boolean expression correctly represents
the Difference (D) output of a full Subtractor?
(a) D=A® B ® Cou

(b) D=A® B @ Bi,

(cc D=A®B
(d) D=A ANDB
Ans. (b) :
Ae] )
B e—l Full
Subtractor —eB_,
B,e—

Difference (D) = ABB,, + ABB,, +ABB, + ABB,
= A(BB, +BB, )+ A(BB, +BB,))

= A(B®B,)+A(B®B,)
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